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Custom Web ADI Integrators 

John Peters 
JRPJR, Inc. 

john.peters@jrpjr.com 



Introduction 

• John Peters, Independent Consulting in the SF Bay 
Area 

 

• I have been working with Custom Web ADI to create 
a JE I/F for SubLedger Accounting. 

– Web ADI loads to a staging table 

– Derivations and validations are run against the staging table 

– Then the interfaced to the base XLA tables using the API 
XLA_JOURNAL_ENTRIES_PUB_PKG 

 The client uses this to interface in JE’s from external 

systems 
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Presentation 

• Please download this presentation to your laptop so you 
can follow along during the hands on sections 

 

http://norcaloaug.com/seminar_archive/2011_training_day_pres/ 

 

Scroll down to the session 5.12 
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This is a Hands On Session 

• I will present some material 

• You will be able to log on to a 12.1.3 instance and try 
it out 

• You will need IE 7 or IE 8 (preferred) 

• You will need Microsoft Excel 2007 or 2010 
(will work with older versions but settings) 

• There is only one of me and up to 40 of you, if you 
can try to help one another that would be a great 
help to everyone in this session 

• Get my attention if you are still stuck, you are 
probably not the only one 
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This is a Hands On Session 

• Some of the material I was trying to present is not 
working in our 12.1.3 instance. 

 

• Therefore some of the hands on sections I will demo 
for you and take you as far as we can go until we get 
errors. 
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What is Web ADI 

• Not the same old Desktop ADI (Client ADI) 

• Nothing to pre-install on the PC, all downloaded from 
the web browser 

• Works with current Microsoft Excel, Word, and 
Project (32 bit versions) 

• Only ADI tool available in R12, but works with 11i 

• Only ADI tool available for Vista and Windows 7 OS’s 

• Good resource for supported versions and other info, 
ML Note: 417692.1 Installing, Configuring and 
Troubleshooting Web ADI 
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Web ADI Integrators 

• It is a set of data structures in the DB that define an 
“Integrator” 

• Various “Layouts” can be applied on top of one 
“Integrator” to create specific tools for different 
groups of users 

• Ability to create the Web ADI “Document” from a 
user menu item and download it to the users desktop 

• Web ADI Documents can be both 

– Data extracted from the E-Business Suite 

– Data interfaced into the E-Business Suite 
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Web ADI Uses In E-Business Suite 
• Web ADI Integrators are now used by many modules 

in the E-Business Suite, it has become a tool that all 
development groups use.   

• Over 240 Integrators predefined by Oracle in 12.1.3 
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APPLICATION_NAME COUNT(*) APPLICATION_NAME 
COUNT(*
) 

APAC Consulting Localizations 9 Operations Intelligence 3 

Advanced Benefits 4 Oracle Price Protection 3 

Advanced Product Catalog 5 Payroll 32 

Application Report Generator 1 Projects 7 

Assets 5 Public Sector Financials International 6 

CRM Foundation 6 Public Sector HR 5 

Custom Development 1 Public Sector Payroll 3 

Enterprise Performance Foundation 6 Report Manager 2 

Financial Consolidation Hub 11 Sales 2 

Financial Intelligence 2 Sales Offline 1 

Financials Common Modules 1 Scheduler 1 

General Ledger 5 Site Management 2 

Human Resources 83 Student System 9 

Incentive Compensation 1 Supply Chain Intelligence 5 

Information Technology Audit 1 Trade Management 4 

Internal Controls Manager 9 Transfer Pricing 2 

Learning Management 2 Web Applications Desktop Integrator 1 

Marketing 3 iSupplier Portal 1 



This Session 

• We are going to concentrate on creating Customer 
Web ADI Integrators for uploading data to the E-
Business Suite from Excel 
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Pre-Web ADI Method of Interfacing  
Data to E-Business Suite 

• Some Steps to create data 

• Create a delimited file  

– (comma, tab, pipe, etc) 

• Upload file to server 

– ftp, scp, custom OA Framework Upload Page 

• SQL*Loader Concurrent Program to load into table 

– Handle SQL*Loader Parsing Errors 

– File Handling, good, discards, bad 

• Concurrent Program to validate, derive and I/F data 
into the E-Business Suite 
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Custom Web ADI Method of Interfacing Data 

• Some Steps to create data 

• Cut and Paste data into Web ADI Template 

• Upload from Excel 

• Launch Concurrent Program to validate, derive and 
I/F data into the E-Business Suite 

 

• Web ADI elminates the steps associated with: 

– Flat file transport 

– Parsing/loading 

– File handling after loading 
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PC Setup Changes 

• You must change security settings in IE 

 

• You must change security settings in 
Microsoft Excel 

 

• ML Note: 1077728.1 Using Microsoft 
Office 2007 and 2010 with Oracle E-
Business Suite 11i and R12 
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IE Browser Settings 

• Select 'Tools' -> 'Internet Options -> 
'Security' (Tab) from the browser menu. 

• Select the appropriate zone i.e. 'Trusted 
Sites' -> 'Custom Level' (button) 

• Under the 'Downloads' section ensure 
'File download' is enabled. 
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IE Browser Settings (cont) 

• Select 'Tools' -> 'Internet Options -> 
'Security' (Tab) from the browser menu. 

• Select the appropriate zone you are 
using i.e. 'Trusted Sites' -> 'Custom 
Level' (button) 

• Set 'Allow Status bar updates via script' 
to 'Enable'. 

• I also identify the server as a Trusted 
Site 
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Excel 2010 Users 

• Click File -> Options  

• Click 'Trust Center' link in the 'Excel Options' window.  

• Click 'Trust Center Settings...' button.  

• In the 'Trust Center' window click 'Macro Settings' 
link from the menu on the left.  

• Under 'Macro Settings' check 'Disable all macros with 
notification'.  

• Under 'Developer Macro Settings' check 'Trust Access 
to the VBA project object model'.  

• Click 'OK' button to close the 'Trust Center' window. 

• Click 'OK' button to return to the spreadsheet.  
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Excel 2007 Users 

• Click the Office Button (top-left button in the window)  

• Click the 'Excel Options' button.  

• Click 'Trust Center' link from the menu on the left.  

• Click 'Trust Center Settings...' button.  

• In the 'Trust Center' window click 'Macro Settings' link from the 
menu on the left.  

• Under 'Macro Settings' check 'Disable all macros with 
notification'.  

• Under 'Developer Macro Settings' check 'Trust Access to the 
VBA project object model'.  

• Click 'OK' button to close the 'Trust Center' window. 

• Click 'OK' button to return to the spreadsheet.  
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Lets Test Our Settings 

 

• Instance: http://visr12norcal.solutionbeacon.net 

• Userid/Password: JP_USER / welcome123 

• Responsibility: Desktop Integration 

• Navigation Path:  
Desktop Integration => Create Document 
Integrator: General Ledger – Journals 
Viewer: Excel 2003 
Layout: Functional Actuals – Single 
Content: None 
Create Document 
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You should see 
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Oracle Docs 

• Oracle E-Business Suite, Desktop Integration 
Framework Developer's Guide, Release 12.1, Part 
No. E15877-02 

• Oracle Web Applications Desktop Integrator, 
Implementation and Administration Guide, 
Release 12.1, Part No. E12902-04 

• ML Note: 396181.1, Oracle Web Applications Desktop 
Integrator Documentation Resources, Release 12 

– Transfer of Information OnLine Training 
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Steps for Custom Web ADI 

1. Create an Integrator 

– Table or API to insert into 

2. Create a Component (optional) 

– List of Values to be used by the Integrator 

3. Create a Layout 

– The display of the columns from the Integrator 

4. Create a Document  

– This is the actual Web ADI Template 

– Optionally Save as a Function 
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Create an Integrator 

• You can think of an Integrator as an Interface 
definition 
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Create an Integrator 

• Typically this step will be performed by a developer 
or someone with technical background 

• Instance: http://visr12norcal.solutionbeacon.net 

• Userid/Password: JP_USER / welcome123 

• Responsibility: Desktop Integration Manager 

• Navigation Path:  
 Desktop Integration Manager => Create Integrator 

 

• I will discuss these steps, due to changes in 12.1.3 
our instance is not working for this at this time. 
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Create an Integrator (1 of 5) 

• In the following examples replace <NN> with the number on your 

registration card 

• Integrator Name: JP Receivable I/F <NN> 

• Internal Name: JP_RA_IF_<NN> 

• Application: Receivables 

• Reporting Only: Unchecked 

• Enabled: Yes 

• Display in Create Document Page: Checked 

• Function: Desktop Integration - Create Document 
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Create an Integrator (1 of 5) 
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Create an Integrator (2 of 5) 

• Interface Name: RA I/F Lines 

• Interface Type: Table 

• Table Name: RA_INTERFACE_LINES_ALL 

 

• Click Apply 
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Create an Integrator (2 of 5) 
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Create an Integrator (2 of 5) 
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Create an Integrator (2 of 5) 

• Click in the empty circle under Select for your Interface Name 

 

• Wait up to 1 minute for the page to redisplay the columns from 

the I/F table 

 

• This next page allows you to identify which columns will be used 

in your integrator, we will come back to this page in a bit 

• This page display very slowly in FireFox and is not usable in that 

browser, you should be using IE for this demo 
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Create an Integrator (2 of 5) 

• In this form you can specify: 

– Prompts for columns 

– If the columns are enabled 

– If the columns are displayed 

– Column defaulting 

• These are global level settings for this Integrator, later on with 

Layouts I will show how you can create different types of 

interfaces from one common Integrator. 
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Create an Integrator (2 of 5) 
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Create an Integrator (3 of 5) 

• Contents allow you to run a query and display the result in the 

downloaded Web ADI Document 

• This is how a download (or report) Web ADI will get it’s content 

• This can be used for an upload Web ADI to initially populate the 

spreadsheet with data the user modifies then uploads 
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Create an Integrator (3 of 5) 
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Create an Integrator (4 of 5) 

• Uploader’s allow you to perform tasks with the data as you 

upload it 

– Identify which rows to upload 

– Validations to Perform 

– Run an Import Process after records are inserted 

• Uploader: None 
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Create an Integrator (4 of 5) 

NorCal OAUG Training Day, Pres 5.12 John Peters, JRPJR, Inc. 34 



Create an Integrator (5 of 5) 

• The Importer identifies what the Integrator should do with data 

that has been uploaded to the I/F tables, typically submit a 

process to import the data into the base E-Business Suite 

• Importer Type: Asynchronous concurrent request 

• Importer Name: JP_RA_IF_<NN> 

NorCal OAUG Training Day, Pres 5.12 John Peters, JRPJR, Inc. 35 



Create an Integrator (5 of 5) 
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Integrators and I/F Tables 

• An Integrator can only insert records into one table. 

• Oracle does not support inserts into multiple tables at this time. 

 

So how do you perform Header and Line I/F Table Inserts? 

There is a way around this using a PL/SQL Procedure 

• Procedure must take header/line level data 

• For each record query for header record 

• If it exists reference it 

• If it does not exist insert it 
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PL/SQL API Integrators  

• The same steps we used to create an Integrator to an I/F table 

can be used to create an Integrator to a PL/SQL API 

 

• The parameters for the PL/SQL API Procedure are identified as 

columns in the Integrator and hence the Excel Document 
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Define a Layout 

• The Layout identifies what columns from the Integrator are 

available for the users to use, defaulting, prompts, etc., as you 

saw with the Integrator 

• You can create many different interfaces using unique Layouts 

all linked to one Integrator 

 

• In my clients case we have one SubLedger Accounting JE 

Integrator but the Layouts allow me to have very specific 

interfactes: 

– AP Accrual JE’s 

– AR Accrual JE’s 

– An interface for each separate feeder system 
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Define a Layout 

• Can be performed by users as opposed to technical 
team 

• Instance: http://visr12norcal.solutionbeacon.net 

• Userid/Password: JP_USER / welcome123 

• Responsibility: Desktop Integration 

• Navigation Path:  
 Desktop Integration => Define Layout 

 

• You can follow along with these steps. 
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Define Layout (1 of 5) 

• Integrator: General Ledger – Journals 

• Go 

• Create (or Duplicate) 

• Layout Name: JP_GL_JE_IF_<NN> 

• Number of Headers: 1 

– These are blocks of  Header fields that are place across the top of the 

Excel Document 
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Define Layout (1 of 5) 
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Define Layout (2 of 5) 

• Required Fields 

• Optional Fields 

– Context: Appears at the top of the spreadsheet as read-
only, contextual information 

– Header: Fields whose values do not change for every 
record you are uploading 

– Line: Fields whose values change for every record 

 

– Default Values and Default Values 

 

– For optional fields Select them using the check box to 
include them in your layout 
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Define Layout (1 of 5) 
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Define Layout (3 of 5) 

• Protect Sheet: This is the default value, the user can change it 
by using Tools : Protection 

• Style Sheet: Style sheets define the fonts and colors used in 
your document 

• Apply Filters: This is the default value for filters in the Lines 
region of the Excel Spreadsheet 

• Title: The title for the Excel Spreadsheet 

• Prompt, Hint, Data Span: The number of columns the 
Header Prompts will span 

• Move Up, Move Down: Move the fields up or down 
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Define Layout (1 of 5) 
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Define Layout (3 of 5) 

• Data Entry Rows: Number of rows to intially create in the 
spreadsheet.  Word of caution, if you define a default value, 
then make the column Read Only you won’t be able to clear the 
data and upload the rows. 

• Move Up, Move Down: Move the Columns left or right 

• Read Only: Column values can not be edited 

• Width: The number of characters wide the column will be 

• Frozen Pane: Column that is the last one in the frozen pane 
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Define Layout (1 of 5) 
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Create a Document 

• Can be performed by users as opposed to technical 
team 

• Instance: http://visr12norcal.solutionbeacon.net 

• Userid/Password: JP_USER / welcome123 

• Responsibility: Desktop Integration 

• Navigation Path:  
 Desktop Integration => Create Layout 

 

• You can follow along with these steps. 
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Create Document 

 

• Integrator: General Ledger – Journals 

• Viewer: Excel 2003 

• Layout: JP_GL_JE_IF_00 

• Content: None 

• When you get to the final screen you have two key 
choices: 

– Create Document – Launches Excel and downloads 
spreadsheet 

– Save – This will save the “Create Document” as a menu 
function that you can integrate into your menus 
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Create Document 

 

• If you save your Document the following dialog will 
pop-up 

• Shortcut Name: JP_GL_JE_<NN> 

• This will create menu function called: 
BNE_JP_GL_JE_00 
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Create Document 
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Create Document Function 
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Some Workarounds 

 

• The following are some workarounds I have found 
based on issues I have hit 
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Clearing the OA Framework Cache 

 

• Responsibility: Functional Administrator 

• Navigation Path: 

Core Services => Caching Framework => Global Configuration 
=> Clear All Cache 

• ML Note: How To Clear The Cache Using Functional 
Administrator? 759038.1  

• WARNING: Clearing the OA Framework cache in a PRODUCTION instance can cause 

data issues if multiple users are engaged and transacting data in the application at the time 
cache is cleared.  Please only utilize this in Production if advised by Oracle Support Services 
or Oracle Development.  
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Clearing the Web ADI Cache 

• Sometimes after creating an Integrator it is not 
available in the Create Document menu option 

• ML Note: 799646.1 ‘Integrator Not Available In 
Create Document List After Form Function 
Association’ 

• Enter the following URL into your browser: 
http://<server>:<port>/OA_HTML/BneAdminServlet?bne:action=cache-clear 

• Then press the back button to get back to the 
Navigator page and continue working 
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Clearing the Web ADI Cache 

• Sometimes after creating an Integrator it is not 
available in the Create Document menu option 

• ML Note: 799646.1 ‘Integrator Not Available In 
Create Document List After Form Function 
Association’ 

• Enter the following URL into your browser: 
http://<server>:<port>/OA_HTML/BneAdminServlet?bne:action=cache-clear 

• Then press the back button to get back to the 
Navigator page and continue working 
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Summary 

• Custom Web ADI allow you to create Excel extracts 
easily 

• Custom Web ADI also allows you to simplify the steps 
for data uploads to the E-Business Suite 

• Realize that this is a fairly new tool and undergoing 
many enhancements on a frequent basis 

• It might be a little rough around the edges and the 
documentation might be a bit on the light side 

• I will be updating this presentation as I continue 
work on this for my client and prepare for presenting 
it at Collaborate’11 
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• My contact information: 

 John Peters 

john.peters@jrpjr.com  
http://www.jrpjr.com 

  

• Additional reference papers can be 
found at: 
http://www.norcaloaug.org 

 http://www.jrpjr.com 


